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1. Introduction

Welcome to PhoneMaster™ Desktop Call Control, the software
that lets you manage your telephone activity from your PC.
PhoneMaster handles outbound and incoming calls, and allows
you to customize your phone to match the way you work.

1.1 PhoneMaster features
• Easy-to-use point-and-click interface allows you to manage your phone through your PC. There’s no

need to memorize complex telephone function keys and codes. PhoneMaster uses the standard
Windows™ interface.

• Easy look up and dialing - use the customized phone directory to dial or transfer calls.

• Caller ID displays caller information before you answer the call so you can improve your productivity and
be more responsive to callers.

• Automatic forwarding of calls to another number or to voice mail when your extension is busy or not
answered.

• Visual voice mail message display on your PC to manage your messages.

• Speed dialing for frequently called numbers.

• Automatic Phone Book entry function to build a personal phone directory.

• “Do not disturb” for times when you cannot be interrupted by phone calls.

• Call Log database to track your external calls and provide valuable call history information - even when
call was not picked up.

1.2 About this manual
This manual assumes that you are familiar with basic Windows 3.1, Windows 95 or Windows NT operations
such as entering information in dialog boxes, clicking Cancel to cancel an operation, and clicking OK to
complete an operation.
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This manual contains information on how to:

• Install the PhoneMaster software

• Perform basic telephone functions

• Manage your calls

• Use PhoneMaster in a workgroup

• Customize PhoneMaster

• Use the optional VoiceMaster product to manage your voice mail.

1.3 PhoneMaster Help
You can get information about PhoneMaster by clicking Help on the menu bar:

• Contents - Displays a listing of help subjects available.

• Topic Search - Allows you to enter a topic in the dialog box and go to that information.

• About PhoneMaster - Provides information about the version of the PhoneMaster application and
components currently installed on your system.

To display context-sensitive help as you are using a dialog box function, click the box’s Help button, or press
the F1 key.

PhoneMaster also has “Tool Tips” that display the function name and/or usage hints when you pass the
cursor over an item.

Note: This guide describes default settings provided by the manufacturer of the PhoneMaster
application. If your system has been reconfigured or customized, this information may not be accurate. If
there are discrepancies, please consult your NetPhone system administrator.
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2. PhoneMaster Quick Start
If you have used the previous version of this product, or if you are familiar with Windows-based applications,
you can use PhoneMaster as soon as it is installed. The PhoneMaster software is easy to use and intuitive,
however, you should take the time to read this guide and become familiar with all of its features.

2.1 Starting PhoneMaster

1. If you are running Windows 95 or NT, click the Start button, point to Programs, and then click the
PhoneMaster entry in the list of programs. If you are running Windows 3.1 double-click the
PhoneMaster icon in your program folder.

2. When the PhoneMaster Login window appears, enter the requested information.

2.2 Dialing a call
To dial a call, double-click an entry in the Directory window on the right side
of the PhoneMaster window, or click the Dialer button on the tool bar. When
you use the Dialer, enter the numbers through your computer keypad, or by
clicking the keypad representations. When you have entered the number, click
Dial. You can also dial calls using your handset. See Dialing calls on page 11 for
more information.

2.3 Answering a call
Calls to your extension appear in the Call List window, with the status message “incoming.”

Once you have answered the phone by picking up your handset receiver you can:

• Place the call on hold by clicking the Hold button.

• Transfer the call to another extension by clicking an entry in the Workgroup or Company listing and
then clicking the Transfer button.

• Send the caller to your voice mail by clicking the My VMail button.

• Send the call to another extension’s voice mail by clicking a directory entry to select a destination mailbox
and then clicking the Mailbox button.

Note: If PhoneMaster is not installed on your PC, see PhoneMaster Installation and Setup on page 5.
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• Hang up the receiver when done or click the Hang Up button. You can then click Dialer or double-click
a listing entry to dial a new call.

When you have an incoming call while you are connected to another call, place the current call on hold, select
the incoming call entry, and then click Pick Up. You can also double-click any call entry to pick up, thereby
placing your other call on hold.

See Answering calls on page 12 for more information.

2.4 Playing a voice mail message

The Voice Mail button shows an envelope in the mailbox and a raised flag
when you have messages in your inbox. Click the Voice Mail button to open
the voice mail window (Ctrl+O). Your voice mail messages appear on two
tabbed pages: Inbox and Saved Messages. Double-click a message to play it, or
click once on the message to select it, then use the play control buttons. See
Using VoiceMaster Voice Mail on page 35 for more information.

Note: This requires optional VoiceMaster software.
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3. PhoneMaster Installation and Setup

3.1 System requirements
• 386/33 MHz or greater PC

• 3.5 inch disk drive

• 8 MB RAM

• 8 MB disk space

• • Microsoft Windows 3.1, Windows 95 or Windows NT

3.2 Installing PhoneMaster
You can install PhoneMaster either from diskette, CD or from a network server. PhoneMaster installation
takes approximately five minutes.

PhoneMaster Installation

PhoneMaster Desktop Call Control will generally be installed on all PC clients, as well as the server. The
client must have mapped drives to the NetPhone server and VoiceMaster (if using VoiceMaster voice mail).

1. Insert NetPhone CD in the client PC to autorun the installation utility.

2. Select NetPhone Client for Windows 95 or NT4.0, then click Next.

3. You will be prompted through the installation process. The next windows displayed will prompt you for
locations and names of the NetPhone Software Folder,  Server System folder, and Program Icons folder.
You may accept the defaults or modify these entries.

4. When complete, click Exit and remove the NetPhone CD.

Network installations:

PhoneMaster clients can be installed over the network if the NetPhone CD is mounted in a drive accessible to
the client PC, or if the installation CD contents have been copied to an accessible directory (you may not use
long directory names or spaces in the directory name).

Note: If you elect to install into a directory other than the default, select an eight  character (or
fewer)directory name.
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3.2.1 To install from a network server
If your system has the PhoneMaster setup files available on the server accessible by your PC, you can install
over the network (your system administrator will provide locations).

1. Map the NetPhone installation directory to a drive letter on your PC.

2. Double-click the file SETUP.EXE in the NetPhone installation directory. The installation process will
then be the same as described in the previous sections.

3.3 Starting PhoneMaster
1. Click the Start button, then point to Programs.

2. Click PhoneMaster.

(Power User Hint: You may create a desktop shortcut to PhoneMaster or add it to the Microsoft
Office tool bar.
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3.4 Entering login information
 The first time you start PhoneMaster, the Login dialog box appears.

1. Select the server name from the list provided. Consult your system administrator about server choices.

2. Enter your username and password as assigned by your system administrator, and your telephone
extension number. You can log in as a different extension by changing this information.

3. (Optional) Check the Save Password box so that PhoneMaster stored your login information. Then, you
will not need to enter this information the next time you login to PhoneMaster.

4. Click OK.

If PhoneMaster displays the error message “Unable to Connect to Server” in the status bar at the bottom of
the window, re-check the login information and try again by selecting Login from the File menu. If the
problem persists, contact your system or network administrator.

3.5 Setting up directories
When PhoneMaster is first installed on your PC, blank default directories are displayed. Follow the steps
below to install your own company’s listing and begin building your Workgroup listing.

1. Select Refresh Company Listing from the File menu.

2. When the “Do you want to browse for the Company listing to copy?” dialog box appears, click Yes.

3. Select the file to use as your Company listing. Your system administrator will supply you with this
information.

4. When asked if you want to overwrite the Company listing, click OK.
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5. When the message box “Update of Company listing completed.” displays, click OK.

You now have an updated Company listing, and a Workgroup listing showing an entry for your extension.
You can now add additional Workgroup listing entries. See Modifying the Workgroup listing on page 21 for
details.
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4. PhoneMaster Basics

4.1 PhoneMaster window

When you start PhoneMaster Desktop Call Control, the application window displays. The PhoneMaster
window components are:

• Menu Bar at the top of the PhoneMaster window with pull down menus.

• Tool Bar with buttons to click for various PhoneMaster functions.

• Active Call window to display the currently active call.

• Call List window where calls are displayed.

• Call Function Buttons to perform actions on the selected call.

Toolbar

Menu Bar

Status Bar

Directory window

Call Function
Buttons

Active Call window

Call List
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• Directory window with tabbed pages for Workgroup and Company listings, Phone Book and Call Log.

• Status Bar showing your extension number and the current program status, for example “Not Connected
to Server,” “Getting Server Status,” or “Connected to Server.”

4.1.1 PhoneMaster tool bar
The PhoneMaster tool bar contains icons you can click to perform tasks.

Login

VoiceMail

Forward Phone

Do Not Disturb

Dialer

Cut

Copy

Paste

Call Log

Workgroup

Company

Phone Book
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4.2 Dialing calls
There are several methods you can use to dial calls from the PhoneMaster application on your PC.

4.2.1 Dialing calls with the Dialer
1. Click the Dialer button on the tool bar to display the Dialer window

(Ctrl-D).

2. Enter a phone number by using the standard letter and numeric keys,
numeric keypad, or by clicking the key representations on the Dialer.
When using letter keys, PhoneMaster interprets them as the corresponding
phone keypad number, for example, A = 2.

3. Press Enter or click Dial to dial the call. If your telephone receiver is still
on its cradle, your phone will ring to signal that the call is being dialed.

4.2.2 Dialing with speed dial entries
The Dialer’s speed dialing function allows you to program up to eight speed dial buttons. You can store up to
24 in the speed dial directory. Click a speed dial button or double-click an entry in the speed dial list, and the
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Dialer automatically dials the number associated with that name. See Storing speed dial entries on page 27 for
more information.

4.2.3 Dialing from a directory listing
You can use a PhoneMaster directory as a dialing source. To do so, do one of the following:

• Double-click an entry in the Company or Workgroup listing to dial a call.

• Double-click an entry in the Phone Book or Call Log. PhoneMaster then displays the Dialer, with the
number inserted. Click Dial or press Enter to dial the call.

If you do not wish to complete the call, replace the receiver in the cradle or click Hang Up.

4.2.4 Dialing from the Active Call window
Enter a number in the Phone field of the Active Call window, then press Enter.

4.3 Answering calls
When your extension rings, the status field of the call entry reads “incoming.” If you have no other active
calls, lift your telephone receiver.

To answer a call while currently connected to another call do one of the following:

• Place connected call on hold, then select the incoming call entry and click Pick Up  (Ctrl+P).

• Select the incoming call and click Pick Up. Doing so automatically places your connected call on hold.

• Double-click the incoming call to pick up and automatically place your connected call on hold.

If you are on a call and call waiting is enabled, you will hear the call waiting beep if you receive an incoming
call. The incoming call appears in the Call window.

4.4 Hanging up a call
Click the Hang Up button or replace the telephone receiver on its cradle to end a call.

4.5 Placing a call on hold
Click the Hold button (Ctrl+H) to place the current call on hold. To reconnect with the call, select the entry
and then click Pick Up, or double-click the entry. Doing so automatically places any other connected call on
hold.

(Power User Hint: Use the edit functions to copy a phone number from a document, a mail message
etc. and then paste into the phone field for dialing.



PhoneMaster User’s Guide 13

4.6 Call Parking
Call parking places a call in a “parking station”.  For example, a call comes in for someone who is not at their
extension. The call is parked, and the person is paged. They can pick up the call from any extension by
dialing the pickup sequence and entering the park station location.

To park a call:

1. Select the call.

2. Select Park from the PhoneMaster Call menu.

3. A confirmation message will display showing the parking station number. If unsuccessful, an error
message will display.

To park a call using the handset:

1. Place call on hold.

2. Enter *30 (plus the two-digit station number). For example, to park a call In station #2, enter *3002.

3. Listen for confirmation tone (3 slow beeps). If you get a reorder tone, try parking in another station.

Note: Valid parking stations are 1 through 99.

To retrieve a parked call:

From the handset, enter *31 (plus the two-digit station number). For example, to retrieve a call parked In
station #2, enter *3102.

(Power User Hint: To see what calls you have parked, look in your Call Log. Parked calls are designated by
“P” and the parking station is noted in the memo field.

Note: If you hang up your telephone while you have a call on hold, it will ring and connect you to the
held call when you pick up.
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5. Managing Your Calls with PhoneMaster

5.1 Transferring calls
PhoneMaster lets you make unannounced (blind) and announced transfers. A confirmation dialog will display
before the call is transferred.

(Power User Hint: You can disable the confirmation message with PhoneMaster’s Preference
settings. See page 23 for details.

5.1.1 Blind transfer
To transfer a call without announcing the caller to the transferee (blind transfer):

1. Select a destination extension by clicking an entry in the Company or Workgroup listing.

2. Click Transfer.

3. When the confirmation dialog appears, click OK to complete transfer.

5.1.2 Announced transfer
An announced transfer allows you to announce the caller to the transferee:

1. Place the caller on hold.

2. Dial a destination extension or select a destination in a directory. Double-clicking a transfer destination
places the caller on hold and connects with the transfer destination.

3. When connected, announce the transfer.

4. Select the held call.

5. Click Transfer.

6. When the confirmation dialog appears, click OK to complete the transfer.



Managing Your Calls with PhoneMaster

PhoneMaster User’s Guide16

5.2 Sending calls to voice mail

5.2.1 Sending a call to your voice mail
To send a call directly to your voice mail without answering the call:

1. Click the call to select.

2. Click Send to My VMail. There will be a confirmation request before the caller is sent to your voice
mail.

3. When the confirmation dialog appears, click OK.

5.2.2 Sending a call to another voice mailbox
To send a call to a selected voice mailbox:

1. Select a destination extension in the Company or Workgroup listing.

2. Click Send to Mailbox.

3. When the confirmation dialog appears, click OK.

5.3 Creating conference calls
To create a conference call, you must be connected to a call and have at least one other call on hold.

To conference in the held call:

1. Select the held call.

2. Click Conference (Ctrl-Y). The conferenced phone numbers appear in the Active Call window.

3. Add additional held calls to the conference by repeating this procedure.

To add new calls to the conference:

1. Place the conference on hold.

2. Dial and connect to a new call.

3. Select the held conference.

4. Click Conference (Ctrl-Y).

To exit a Conference:

1. Click Hang Up.

2. When the dialog box appears with options to hang up the entire conference, or remove only your
extension from the conference, click the options you want, then click OK.
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5.4 Do Not Disturb

5.5 Forward Phone

See Specifying forwarding settings on page 28 for information about specifying forwarding numbers.

Click the Do Not Disturb tool bar button to activate/deactivate Do Not
Disturb for your extension. When Do Not Disturb is active, your incoming
calls forward to voice mail or to a number specified in your setup. If no
forwarding is set, callers will hear a busy signal.

Click the Forward Phone tool bar button to activate/deactivate automatic
forwarding of your calls. When activated, your incoming calls forward to voice
mail or to the number specified in your setup.
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6. Using PhoneMaster in a Workgroup

6.1 Viewing PhoneMaster directories

The PhoneMaster Directory window shows:

• The Company listing

• The Workgroup listing

• The Phone Book

• The Call Log

Click the tab at the bottom to go to a directory, or click the tool bar button for the directory you want to
display.
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You can reorder the columns of the directory by positioning the cursor in the heading of the column you wish
to move, dragging it right or left as desired. You can change the column width by positioning the cursor
directly on the column boundary in the heading section and dragging right or left.

See Searching for and sorting directory entries  on page 26 for additional information.

6.1.1 Company listing
The Company listing shows the name and title/department for each extension listed in the company database
You can use the Company listing to dial or transfer calls, however, the Company listing does not display the
status of extensions.

See Refreshing and replacing the Company listing on page 24 for additional information.

6.1.2 Workgroup listing
The Workgroup listing is built from the Company listing. The Workgroup listing shows the extension
number, name and department for each extension included in your Workgroup. If you want to use
PhoneMaster to cover (monitor status and pick up calls) for another extension, that extension must be
included in your Workgroup listing as well as in your Cover Group.

You can use the Workgroup listing as a source for dialing or for transferring calls.

The Workgroup directory displays the following icons in the extension field, showing the current activity
status of an extension:

Off Hook - the extension is in use

Ringing - the extension is ringing

DND - extension has been set Do Not Disturb

6.1.3 Phone Book
The Phone Book listing is a personal phone directory that displays a phone number, name and memo field for
each entry. You can use the Phone Book listing as a source for dialing or for transferring calls.

Note: You must move the insertion point from the record in order for changes to take effect. If your
call ends before you complete editing, the entry will not be made.

While dialing or connected to a call, click the Add to Phone Book button. to
add the information to your Phone Book. You can also edit the Phone Book
manually to add, remove, or modify entries.
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6.1.4 Call Log
PhoneMaster’s Call Log maintains a record of the outside calls made to and from your extension (incoming
calls are logged even if not answered). The Call Log entries list the following details:

• Incoming calls denoted by I, outgoing by O.

• The date, time and length of call.

• Phone number you called.

• The number that called your extension, if available from Caller ID.

• The name of the party being called. If unavailable from Caller ID, the phone number displays.

• Memo text if available through database lookup.

• The caller’s extension

• The Caller ID phone if available from Caller ID mapping.

• The Caller ID name if available from Caller ID mapping.

To use the Call Log as a dialing source, double-click an entry. The Dialer appears with the phone calling
information inserted, ready to dial the call.

To delete entries from the Call Log, click anywhere on the entry and press the Delete key.  Note: Call Log
entries can be deleted, but not edited.

6.1.5 Modifying the Workgroup listing

You can modify your Workgroup listing by deleting entries or copying entries from the Company listing.
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To modify your Workgroup listing:

1. Select Modify Workgroup from the Edit menu.

 The Edit Workgroup window appears, showing your current Workgroup listing on the left, and the
Company listing on the right.

2. To add a Workgroup listing entry, click a Company listing entry, then click the left arrow button.
Alternatively, you can double-click the Company listing entry.

3. To delete an entry from your Workgroup listing, click the entry, then click the right arrow button.
Alternatively, you can double-click the Workgroup entry.

4. When finished, click OK to save your changes and exit the window.

6.2 Picking up ringing calls on other extensions
PhoneMaster allows you to pick up any ringing extension within your Cover Group. To enable Cover Group
pickup you must:

1. Determine the extensions to be part of your Cover Group. (See Enabling Cover Groups on page 30.)

2. Include the extension(s) you want to cover in your Workgroup listing. (See Modifying the Workgroup
listing on page 21.)

3. Enable Call window display for extensions in your Cover Group through the File menu’s Setup option.
(See Enabling Cover Groups on page 30.)

When a covered extension is ringing, it appears in the Call List window. The status icon in the Workgroup
listing is “ringing.”

To pick up the call, do one of the following:

• Select the call and click Pickup.

• Double-click the call.

If the call is picked up by another extension, it no longer appears in your Call window.

Note: Double-clicking an entry in a directory listing dials a call. To pick up a call, you must double-click
in the Call List window.
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7. Customizing PhoneMaster
You can customize many of the PhoneMaster features to meet your requirements. You can:

• Customize the PhoneMaster display.

• Update or replace your local copy of the Company listing.

• Search for and sort entries in a directory.

• Store speed dial entries.

• Specify forwarding settings.

• Enable call waiting.

• Enable Voice Mail.

• Enable Cover Groups, to pick up calls for other extensions in your workgroup.

• Identify callers with Caller ID.

7.1 Customizing the PhoneMaster display
To customize the way PhoneMaster displays on your PC, select View from the menu bar, then select options
to:

• Hide/show status bar and tool bar.

• Show both the Call window and Directory window, the Directory window only, or the Call window
only.

• Split windows to create a separate Call window, Directory window, and PhoneMaster menu/tool bar.
You can move and size these windows independently. PhoneMaster remembers the position and sizes you
have selected the next time you split the windows.

• • Join windows to rejoin the PhoneMaster window elements.

 

To set preferences for PhoneMaster operation, select Setup from the File menu, click the Preferences tab,
then select the options you want.

• Bring program to the front on incoming calls - Brings PhoneMaster to the front of other active windows
when you have an incoming call.
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• Hide the Dialer after dialing - The Dialer will close after dialing. If you do not check this option, the
Dialer will remain open after dialing.

• Sort calls by priority order - Entries in the Call window will display in the following order: 1.
Connected, 2. Calling, 3. Held. If this box is not checked, calls will display in order of appearance.

• Enable confirmation on transfer - Enables/disables display of transfer confirmation message when
transferring calls to other extensions or voice mailboxes.

• Enable Tool Tips - Enables/disables display of hints when your cursor passes over areas of the
PhoneMaster screen. When disabled, hints appear in the status bar at the bottom of the PhoneMaster
window, instead of next to the item.

• Default extension number.

7.2 Refreshing and replacing the Company listing
The Refresh Company Listing option is used to copy the latest version of the file used as your Company
listing, or to select a different file to be used.

1. Select Refresh Company Listing from the File menu.

2. When asked if you want to browse for the Company listing to copy, click No if you want to get the latest
version of the file used. Click Yes if you want to select a different file, then navigate to the file you wish
to use, then click OK..

3. When the message box appears stating “Update of Company listing completed,” click OK.

You have now updated Company and Workgroup listings.
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You can also use the Setup window’s Directories page to select a different file to use as your Company listing
file. To replace your local copy of the Company listing file:

1. Enter a path and file name in the space provided, or click Browse to search for a directory file.

2. Double-click a file name so that path/filename displays in the box provided.
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7.3 Searching for and sorting directory entries
While the cursor is in the Workgroup, Company, or Phone Book listing, press a letter key to select the first
name beginning with that letter or its nearest match. You can also use the Edit menu’s Find option (Ctrl+f)
to search for a name or its nearest match.

You can sort entries in these directories by extension, name, or title. To sort entries, select Sort from the View
menu, or click the right mouse button to display sort options.
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Sort order for text fields is:

1. All entries beginning with an upper case character

2. All entries beginning with a lower case character

3. Entries beginning with non-alpha characters, such as punctuation symbols.

7.4 Storing speed dial entries
1. Click a blank speed dial button, or select Speed Dial from the Dialer’s View menu to open the speed

dial list.

2. Enter the name and phone number.

• For local numbers, you only need to enter the seven digits. For non-local numbers, you must include
the area code.

• Hyphens are not required within the number sequences.

• You can tab through the series of boxes.

• You can use the Edit menu functions Cut, Copy, Paste, and Delete to modify entries.

3. When you finish editing, select Dialer from the window’s View menu to return to the Dialer.
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7.5 Specifying forwarding settings
PhoneMaster can automatically forward calls to your voice mail, to another extension, or to an outside
number if your line is busy, not answered, or you do not wish to be disturbed.

1. Select Setup from the File menu.

2. Click the Forwarding tab to display the Forwarding page.

3. Set the forwarding options based on whether you have enabled the Do Not Disturb or Forward Phone
buttons on the tool bar.

• If the Do Not Disturb button is active, calls forward immediately to your voice mail or to a
designated extension.

• If the Forward Phone button is active, calls forward to another extension or phone number after a
specified number of rings. Enter the extension or phone number in the box provided.

• When neither of the above is active, you can forward all your calls to another extension or phone
number, or to voice mail after a specified number of rings. Enter the extension or phone number in
the box provided.

If you do not want to have calls forwarded when your phone is busy or unanswered, leave the forwarding
number field blank.

Note: If forwarding is set to an outside number, any restrictions on your phone for dialing outside
numbers will apply to your call forwarding. For example, if you set your phone to forward to an area
code you are prohibited from calling on your extension, calls will not forward.

Note:  When a forwarded caller reaches voice mail, the message will be left in the mailbox for the
extension originally dialed, regardless of there they were forwarded.
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7.6 Enabling call waiting
Call waiting provides a signal tone that lets you know when another call is trying to ring your extension while
you are on another call.

The waiting call transfers to your voice mail or to another number if you do not pick up the call within the
number of rings you have specified for forwarding. If no forwarding number is provided, you will continue to
hear the call waiting tone until you answer or the caller hangs up.

To enable call waiting:

1. Select Setup from the File menu.

2. Click the Forwarding tab.

3. Click the “Enable call waiting” box.

If you do not enable call waiting, calls will forward according to your existing forwarding settings.

7.7 Enabling voice mail
You can enable/disable voice mail for your extension.

1. Select Setup from the File menu.

2. Click the Voice Mail tab to display the Voice Mail page

3. Check the “Enable voice mail” box.

When you enable voice mail, callers are sent to your voice mail according to the settings on the Forwarding
page. If you do not have voice mail enabled, the Forward to Voice Mail choices in the forwarding dialog box
are not available to you.

You can select a voice mailbox to use as your default for message display. Normally this is the mailbox for
your own extension, but it may be for another extension, for example, if you monitor phone messages for
someone else. You will need appropriate file access privileges on the server. Refer to the NetPhone PBX
Installation and Administration guide for details.

You can also set the location of your voice mailbox directory on the NetPhone server. The path to the voice
mail directory must be on a mapped drive, for example: F:\NETPHONE.

PhoneMaster allows you to use a voice mail application other than NetPhone’s VoiceMaster. If you are using
a voice mail application other than VoiceMaster, you need to check the option “Use non-NetPhone Voice
Mail” and enter the command to execute the voice mail application in the box provided. Consult your
NetPhone Administrator for details.

If you choose not to use voice mail, check the “Do not use voice mail” box.
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7.8 Enabling Cover Groups
Cover Groups allow you to pick up calls for other extensions. An operator or receptionist may want to cover
all extensions. Others usually cover only the members of their department or workgroup.

To enable Cover Groups:

1. Select Setup from the File menu.

2. Click the Cover Groups tab to display the Cover Groups page.

3. Check one of the following Cover Group options:

a) Only cover this extension - Enables call pickup only on your own extension (no Cover Group).

b) Cover all Workgroup extensions - Makes all extensions in your Workgroup listing members of your
Cover Group.

c) Cover the following Workgroup extensions - Allows you to specify your Cover Group extensions by
entering extension numbers (separate numbers with commas).

4. Check one of the following notification options:

a) Ring this computer when this extension rings - Enables PC audio alert when your extension is
ringing.

b) Ring this computer when a covered phone rings - Enables PC audio alert when an extension in
your Cover Group is ringing.

5. When Only show calls to this extension in the call display area is selected, only calls to your extension
will be displayed. When not selected, all calls for your Cover Group will be displayed.

7.9 Identifying callers with Caller ID
PhoneMaster Caller ID uses a calling party’s phone number to look up information in a database or from a
DDE (Dynamic Data Exchange) source. PhoneMaster then uses the information from these sources to fill in
fields on the call entry when dialing or receiving a call.

Note: You can only cover extensions included in your Workgroup listing. See Modifying the Workgroup
listing on page 21 for more information.
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To enable Caller ID:

1. Select Setup from the File menu.

2. Click the Caller ID tab to display the Caller ID page.

3. Check one of the following caller ID processing options:

• Look up information from a DDE source. Use the Interfaces page to enter appropriate settings.

• Do not use Caller ID to look up caller information.

• Look up caller information in a FoxPro or Dbase database.

To look up caller ID information in a database:

1. Enter the file name or click Browse to select a file.

2. Enter the field definition names in the external database that correspond to the PhoneMaster field
names Telephone Number, Contact Name, and Company Name.

3. Click OK or Apply when done.

Application programs such as contact managers that are continually updated with new information can share
this information with PhoneMaster for caller ID purposes. The other program must be running in the
background and must support DDE.

If you have elected to look up Caller ID information from a DDE application, you need to enable the DDE
connection and specify the application (DDE server) that will provide the Caller ID information. The DDE
database will then populate the fields in the active call entry.

The field entries link PhoneMaster’s call information fields to the corresponding field names in the DDE
application. This information is specified on the Interfaces page.

1. Click on Interfaces tab to display the interfaces page.

2. Enter your application name in the DDE Service field

3. Enter the name of the database in the Topic field

4. Enter the names of the fields that will link to the PhoneMaster caller ID fields.

5. Refer to the DDE application’s documentation for field name definitions for Phone, Name, Company
and Memo.

To load the default field values for a specific DDE application, select the application name in the scroll box,
and then click Load. If there is no listing of default values for your application, you need to enter them
manually using the field names given in the application’s documentation. To clear the fields above, select
“None” in the scroll box, and then click Load.
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By enabling the “Execute DDE Macro Command on Incoming Calls” feature, the DDE interface uses the
macro specified in the text box. You can use the macro loaded with a DDE application’s default values, or
enter a different macro in the box. When the macro is passed to the application, the following keyword
substitutions are made:

• “FORMATTEDCALLERID” - The phone number formatted as
XXX-XXX-XXXX (For example, 800-992-7433)

• “UNFORMATTEDCALLERID” - The phone number formatted as XXXXXXXXXX (For example,
8009927433)
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7.10 Caller ID mapping
Caller ID mapping makes an automatic substitution when PhoneMaster sees the specified number through
Caller ID. For example, if you receive calls from different phone numbers within the same company, you can
map these numbers so that your return calls go to their main number.

1. Select Caller-ID Map Table from the Edit menu (Ctrl-A). The table window will open for editing.

2. Enter the actual phone number in the Caller-ID column.

3. Enter the corresponding number you wish reported in the Phone column.

4. When you are done editing, click OK.
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8. Using VoiceMaster Voice Mail

8.1 Voice mail window
Click the Voice Mail tool bar button (Ctrl+O) to open the voice mail message window. This window displays
lists of your voice mail messages and function buttons for playing, saving or deleting them. Messages are listed
in the order they are received, with oldest messages at the top of the list.

Note: If you have a voice mail product other than NetPhone’s VoiceMaster installed, it will launch via
this button. Refer to that product’s documentation for information.

The voice mail message lists are on tabbed pages; one for new messages (Inbox), and one for saved messages.
Click the tabs to move between them. These lists show:

VoiceMaster, an optional NetPhone product, is a full-functioned voice mail
system. VoiceMaster allows callers to leave voice mail messages which you can
then listen to, forward and reply to. The PhoneMaster tool bar’s Voice Mail
button shows an envelope in the mailbox and a raised red flag when you have
new voice mail messages.
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• Indicator for unread messages (*).

• The date and time the message was received.

• The length of the message in minutes:seconds.

• For external calls, the caller’s phone number if Caller ID is enabled by your phone company; for internal
calls, the extension number and name.

• An editable memo field where you can place a note about the call. Up to 30 characters will display. If the
memo is longer than 30 characters scroll with arrow key to view the remainder of the memo.

8.2 Playing your voice mail messages
To listen to your voice mail messages, select a message by clicking the entry, then click the function buttons
at the top of the voice mail window, or select the desired function from the VoiceMaster window’s Controls
menu.

Play - Select a message from the list, then click the Play button. Your phone
will ring. Pick up the phone and listen to the message. Double-clicking a
message puts it into play mode automatically.

Pause - Click the Pause button to stop message play. You can resume play from
where you stopped by clicking the Play button.

Replay Message - Click the Replay Message button to replay the currently
selected message from the beginning.

Rewind - Click the Rewind button to “back up” five seconds to replay part of
the currently playing message.

Forward - Click the Forward button to “fast forward,” skipping ahead five
seconds in the currently playing message.

Play Next Message - Click the Play Next Message button to play the next
message after the currently selected message.

8.3 Managing your voice mail messages
Voice mail messages remain in the inbox until you move them to the saved messages page or delete them.

• Select a message by clicking anywhere on the message line.

Note: If you answer a call while playing voice mail messages, voice mail message play stops automatically.
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• To save a message, select it, and then click the Save button. Doing so moves the message to the saved
messages folder.

• To delete a message, select it, and then click the Delete button or press the Delete key. A confirmation
dialog appears before the message is deleted.

8.4 Forwarding voice mail messages
You can forward a voice mail message to another mailbox or group of up to eight mailboxes. You can also
voice annotate the forwarded message, adding your comments to the beginning of the message.

To forward a voice mail message:

1. Select a voice mail message by clicking anywhere on the message entry.

2. Select Forward from the File menu or click the Forward button.

3. If you wish to add an annotation, click Record Annotation. Your phone will ring if you haven’t already
lifted the receiver.

4. Speak into the receiver to record your annotation.

5. Click Stop Recording when the annotation message is complete.

6. Click Review Annotation to replay your annotation message. To change, click Re-record Annotation and
record a new message.

7. Enter the voice mailbox you wish to forward to. You can enter a list of up to eight box numbers,
separating each with a space or a comma.

8. Click the Send button to send the message

9. Click Cancel at any point before clicking Send if you want to cancel the forward.
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8.5 Returning calls
VoiceMaster allows you to return a call to the number in a voice mail listing if Caller ID has supplied a
number.

To return a call:

1. Select a voice mail message by clicking on it.

2. Select Return Call from the File menu or click the Return Call button.

  The PhoneMaster Dialer will be displayed with the number entered.

3. Click Dial or press Enter to dial the call.

8.6 Managing your voice mail from a telephone
VoiceMaster lets you access your voice mailbox from any push-button phone. Once you have entered
VoiceMaster, you can:

• Press star (*) at any time for help hints.

• Press pound (#) during a prompt to end the prompt.

• Press pound (#) during message play to return to the main VoiceMaster menu.

8.6.1 Accessing your mailbox
To access your voice mailbox from an extension:

1. Press *6. You will then be prompted for a mailbox number.

2. Enter the mailbox number, followed by the pound (#) key. (If you are using your own extension, you can
omit the mailbox number and just press the pound key.)

3. Enter your password when prompted, followed by the pound key (#).

 If you enter an incorrect password, the system will re-prompt you for up to two additional attempts. If
you are still unsuccessful it will play a “goodbye” message and hang up.

To access your voice mailbox from an outside phone, for example from home or while traveling, do one of the
following:

• Dial your number and connect to your extension. Press star (*) while your voice mail greeting is playing.
The system will prompt you for your password. When you enter your password successfully, you can
proceed.

• Dial your number and enter *6 while the auto-attendant message is playing.

Once you enter your password, the voice mail system states whether or not you have messages. It then offers
menu choices for playing messages or changing your voice mail greeting and password options.
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• If you have new messages, VoiceMaster announces the number of new (unread) messages you have, and a
menu of voice mail options.

• If you have no new messages, VoiceMaster announces the number of old (read) messages you have, and a
menu of voice mail options.

• If you have no messages (new or old) the system responds “Your mailbox is empty,” and then provides
you with your voice mail options.

8.6.2 Playing messages
When you access your voice mailbox, VoiceMaster tells you how many new messages you have. If you have
messages, VoiceMaster will present you with the following options:

• Press 1 to listen to your messages. The oldest new message will play first

• Press 2 to send a voice mail message.

• Press 3 to change mailbox options.

• Press 0 to dial another extension.

During message play you can:

• Press 7 to rewind five seconds.

• Press 8 to pause message play.

• Press 9 to skip forward five seconds.

After the message plays, you will be offered choices to:

• Press 1 to replay.

• Press 2 for next message.

• Press 3 to delete.

• Press 4 to forward.

• Press 5 to play the previous message.

8.6.3 Forwarding messages
You can forward a voice mail message to one or more mailboxes, with the option of adding an annotation
message. VoiceMaster prompts for destination and annotation options.

1. After playing a message, press 4 to forward.

2. When prompted for a forwarding destination, enter one or more mailboxes to forward to. Separate
individual mailboxes with a pound key. End the list with the pound key.
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3. Press 3 to forward the message without an annotation, press 4 to cancel, or press 2 to add an annotation
to the message (optional). When the annotation has been recorded, you can replace (press 1), use (press
2) or delete (press 3) the annotation.

4. When the annotation is complete, press 3 to forward the message, or press 4 to cancel.

8.6.4 Recording a voice mail greeting
Access your voice mail box and select the greeting option from VoiceMaster’s main menu

If you do not have a greeting, you will hear options to record a greeting. If you already have a greeting you
will hear options to keep or replace the current greeting.

• Press 1 to hear your current voice mail greeting.

• Press 2 to keep your current voice mail greeting.

• Press 3 to replace your current voice mail greeting

If you choose to replace your greeting, VoiceMaster prompts you to record a greeting then offers choices to:

• Press 1 to hear your new greeting

• Press 2 to install your new greeting

• Press 3 to erase your new greeting.

8.6.5 Changing your voice mail password
1. Press 2 to select the change password option from VoiceMaster’s main menu.

2. When VoiceMaster prompts you for a new password, enter a password from 0 to 9 characters long,
followed by the pound (#) key.

When you are prompted to confirm your new password, re-enter the new password. If it matches, your new
password will be installed.

Note: The last voice mail greeting “installed” is the one that will pay when callers reach your voice mail.

Note: The default password is 0 characters (no password). NetPhone recommends installing a new
password before using voice mail.
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9. Phone Keypad Commands
You can perform many NetPhone operations through the keypad of the touch-tone phone for your extension.
This may be required if you do not have access to a PC, or for times when you find using it inconvenient.
You may also wish to keep the NetPhone Keypad Codes reference card by your extension for quick lookup, or
press star (*) on your handset for audio Help.

9.1 Dialing from your extension
Dialing calls with NetPhone is similar to dialing with most Centrex or other business phone systems. The
dialing instructions described below are the defaults supplied with the NetPhone system. You may find
differences if your system has been reconfigured by your system administrator.

To dial... Do this...

An outside local call Press 9, then the seven digits of the phone
number.

An outside long distance call Press 9 + 1, then the ten digits of the phone
number (provided your extension has
privilege to dial toll calls).

Another extension Enter the digits of the extension number

The internal operator Press 0.

911 emergency services Press 911 or 9+911.

Phone company directory assistance Press 9+ appropriate directory assistance
number.

VoiceMaster Express (Leave a message at a Voice Mailbox)

You can leave a message at a mailbox from an extension by pressing *7, the three digit extension, then the
pound key (#). You will be prompted to leave a message. When you have completed your message, you can
hang up, or press the pound key to leave additional voice mail messages.

You can also press “0” to transfer to another extension.
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9.2 Managing calls

9.2.1 Picking up a ringing call on another extension
NetPhone allows you to pick up any ringing extension within your Pickup Group by pressing *5. A Pickup
Group is any set of phone extensions that form part of a group, as assigned by the system administrator.
Usually all extensions within one office or department comprise a Pickup Group.

9.2.2 Placing a call on hold
Depressing and quickly releasing the switch hook (in less than one second) is called a “Flash.” Flashing places
the current call on hold and gives an acknowledge dial tone. You can then transfer or conference the call. If
your phone has a flash button, you may use that in place of the switch hook.

9.2.3 Picking up a held call
You can pick up a held call by pressing *4 (pickup Held). If you have a held call, flash to reconnect. If you
have more than one held call, the last call placed on hold is picked up first.

9.2.4 Parking Calls
1. Place call on hold.

2. Enter *30 (plus the two-digit station number). For example, to park a call In station #2, enter *3002.

3. Listen for confirmation tone (3 slow beeps). If you get a reorder tone, try parking in another station.

Note: Valid parking stations are 1 through 99.

To retrieve a parked call:

From the handset, enter *31 (plus the two-digit station number). For example, to retrieve a call parked In
station #2, enter *3102.

9.2.5 Transferring a call (announced transfer)
You can make an announced transfer by doing the following:

1. Flash to place the call on hold.

2. Dial the transferee.

3. When connection is made, announce the caller to transferee.

Note: A Pickup Group set by the system administrator is not the same as the Cover Group set through
PhoneMaster. Members of the Pickup Group can pick up each other’s ringing calls using the handset. The
two groups do not necessarily have the same members.
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4. Place transferee on hold.

5. Press *8 to connect the caller.
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9.2.6 Transferring a call (blind transfer)
You can make a blind transfer by doing the following:

1. Flash to place the call on hold.

2. Dial the transferee and then hang up within five seconds.

If you do not complete the transfer within five seconds, NetPhone assumes you have hung up on the number
you are transferring to. The call will ring back on your extension.

9.2.7 Creating a conference call
To create a conference, press *2 (Conference). This creates a conference of all held calls plus yourself.

9.2.8 Accessing your voice mailbox
1. Press *6. You will then be prompted for a mailbox number.

2. Enter the mailbox number, followed by the pound (#) key. If you are using your own extension, you can
omit the mailbox number and just press the pound key.

3. Enter your password when prompted, followed by the pound key (#).

9.2.9 Forwarding calls
NetPhone allows you to set call forwarding to other extensions or to an outside number when your line is
busy, not answered, or when you do not want to be disturbed. Note that when you set forwarding to an
outside number, any restrictions on your phone at time of forwarding for dialing outside numbers will apply
to your call forward For example, if you set your phone to forward to an area code you are not permitted to
call with your extension, your calls will not forward.

Note: If you have enabled PhoneMaster’s “Restore Forwarding on Startup” option, forwarding set via
the keypad will be overwritten by PhoneMaster’s on restart.
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Forward if Busy

You can set your extension so that calls will forward to another extension or outside number if your line is
busy.

To set Forward if Busy press *92 plus the digits of the number calls will forward to. Enter *88 in place of the
extension number to forward calls to voice mail. To cancel Forward if Busy press *92#.

Forward Immediately

To set your extension so that calls will Forward Immediately to another number press *94 plus the digits of
the number calls will forward to. Enter *88 in place of the extension number to forward calls to voice mail.
To cancel Forward Immediately press *94#.

Forward if No Answer

You can set your extension so that calls will forward if your extension does not answer.To set your extension
to Forward if No Answer press *96 plus the digits of the number calls will forward to. Enter *88 in place of
the extension number to forward calls to voice mail. To cancel Forward if No Answer press *96#.
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10. Appendix A - Troubleshooting

Problem Assessment and possible solutions

PhoneMaster icon not
visible or not on
program list.

PhoneMaster software is not installed or in a different
folder. Consult your system administrator or search for
PhoneMaster in other folders.

“Server Not Connected”
message displays.

The server is not connected. Repeat the PhoneMaster
login procedure. If unsuccessful, consult your NetPhone
system administrator.

Unable to access voice
messages.

Your system is unable to access the voice mail server that
contains the voice mail message, or voice mail is not
enabled on the server. Make sure that you have correctly
mapped the drive with voice mailbox folders.

“No NetPhone Servers
Found” message
appears.

PhoneMaster is unable to locate a NetPhone server on the
network. Verify that you are still connected to the network
and that the NetPhone server is running.

Cannot dial outside
number(s).

Your extension may have a class of service restriction.
Consult your system administrator.

Cannot transfer call
successfully using phone
keypad.

You may be taking longer than five seconds to hang up
after dialing the new party. When the call rings back to
you, create a conference with the new party and then hang
up.

Voice Mail directory not
found.

The path to the server’s voice mail folder may be incorrect.
Check the Voice Mail page under Setup and make sure the
server directory is mapped to a drive letter on your
computer and that the path is correct, for example:
F:\NETPHONE

Forwarding enabled, but
calls not transferring to
outside number.

Your extension may have service restrictions, such as “no
long distance calling.” Set forwards in accordance with
your class of service.





Appendix B: Glossary

PhoneMaster User’s Guide 49

11. Appendix B - Glossary

Call Log - The Call Log keeps track of external calls to and from your extension. You can use the Call
Log as a dialing source.

Call mapping - Call mapping for Caller ID allows you to specify what number will be reported to Caller
ID when a specified number is seen.

Call Park - Parking a call places it on hold in a “parking station”. The call can be retrieved (unparked)
from any phone, by entering  *31 (plus the two-digit station number).

Call waiting - Call waiting provides a signal if you are already on a call and another call rings on your
extension. When a second call is announced, you can place the current call on hold and pick up the
second call, or you can ignore the second call.

Call window - The Call window is PhoneMaster’s display of current calling activity for the user’s
extension, and for any other members of the user’s Cover Group.

Caller ID - Caller ID displays the number of the caller on the call entry. If you are looking up caller ID
information from a database, additional information may be displayed. Callers may be able to block Caller
ID, in which case you will not see this information.

Class of service - The class of service designates the selection of features and calling privileges available
to a particular line or extension. All members of a class have the same privileges.

Company listing - The directory of names and phone numbers for your organization. This is a centrally
maintained database. Users have local copies on their PC. Select Refresh Company Listing from the File
menu to ensure you have an up to date copy.

Conference call - Three or more active calls connected so that conversation can be held among all the
parties.

Cover Group - A Cover Group is any set of phone extensions forming part of a group, as selected by
the user through the File menu’s Setup option.

DDE (Dynamic Data Exchange) - DDE applications are shared applications that allow information to
be updated continuously by other users and/or applications. Contact managers are usually DDE
applications.

Flash - To depress and quickly (in less than one second) release the telephone’s switch hook.

Forward - To direct your calls to another extension or voice mail if your phone is busy or not
answered.

Hold - To keep a caller connected while you perform another operation or handle another call. You can
then take the call off hold and continue with that caller.
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Menu bar - The PhoneMaster menu bar (at the top of the application window) has pulldown lists of
commands you can select to perform PhoneMaster functions.

Password - A sequence of characters entered to allow access into computer or phone application, such
as voice mail.

PBX (Private Branch Exchange) - A PBX is a private version of the phone company’s switching
mechanisms, allowing internal phone operations (transferring, dialing other extensions) as well as
connecting to the outside phone network. The PBX is owned by the company using it, rather than the
phone company.

Phone Book - The Phone Book listing is a personalized directory based on your calls. Click the “Add to
Phone Book” button while a call is connected to add the information to your Phone Book.

Pickup Group - A Pickup Group is a set of extensions forming part of a group. Members of the group
can pick up calls ringing on the other extensions by pressing *5 on the phone keypad. This group is set by
the system administrator, as opposed to Cover Groups, which can be set by the user.

Server - A computer on the network that handles operations for all other users, for functions such as
networking or printing.

Shortcut keys - A keystroke sequence to perform a function, for example, Ctrl+O to access voice mail.

Speed dial - A directory of numbers entered into the PhoneMaster Dialer, so that they can be dialed by
clicking the entry. Usually these are frequently called or complex number sequences.

Status bar - The status bar appears at the bottom of the PhoneMaster window and displays current
status of the PhoneMaster server, for example, “Connected,” “Not Connected,” “Getting Server Status.”

System administrator - The person designated as responsible for administering the PhoneMaster
system for an organization.

Tool bar - The PhoneMaster tool bar displays a row of icon buttons that you can click to perform
common operations on a selected call in the call window, to enable/disable Do Not Disturb  or Forward
Phone, or to access Voice Mail  for your extension.

Tool Tips - Helpful messages that display as you pass the cursor over a screen option or area. You can
enable/disable Tool Tip hint display through the Preferences page under Setup from the File menu.

Transfer - Moves a caller from your extension to another number. Transfers can be announced to the
party at the new destination, or can be blind, where the caller is immediately connected to the new
number.

Username - The name associated with your computer accounts, usually assigned by your system
manager.

Voice mail - Allows callers to leave spoken messages at your extension in a “voice mailbox” for you to
retrieve at your convenience.
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Workgroup - The Workgroup listing allows you to monitor the status of the other phones of
workgroup members.
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12. Appendix C - Keystroke Shortcuts
PhoneMaster offers keystroke shortcuts for many functions. The shortcut appear next to the menu entry for
the function.

Function Keystroke Sequence

Dial Ctrl+D

Pickup Ctrl+P

Hold Ctrl+H

Conference Ctrl+Y

Transfer Ctrl+T

Hang up Ctrl+G

Open Voice Mail
Window

Ctrl+O

Send Call to Voice
Mail

Ctrl+S

Send Call to
Selected Voice Mail

Ctrl+M

Cut Ctrl+X

Copy Ctrl+C

Paste Ctrl+V

Find name Ctrl+F

Set/Disable Do Not
Disturb

Ctrl+N

Open Caller-ID map
table

Ctrl+A

Modify Workgroup Ctrl+W
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13. Appendix D - Software License and Warranty
Information

NetPhone, Inc. Limited Software Warranty and License Agreement

IMPORTANT: READ THE FOLLOWING TERMS AND CONDITIONS CAREFULLY BEFORE
OPENING THIS SEALED SOFTWARE PACKAGE. THESE TERMS AND CONDITIONS
CONSTITUTE THE ENTIRE AGREEMENT BETWEEN YOU AND NETPHONE, INC.
(“NETPHONE”) CONCERNING THE PROGRAM, SUPPLIED ON MEDIA (“THE PROGRAM”)
AND THE USER DOCUMENTATION (THE “DOCUMENTATION”).

BY OPENING THIS PACKAGE YOU INDICATE YOUR ACCEPTANCE OF THESE TERMS AND
CONDITIONS. IF YOU DO NOT AGREE WITH THEM, PROMPTLY RETURN THIS PACKAGE
UNOPENED, ALONG WITH THE DOCUMENTATION, AND YOUR MONEY WILL BE
REFUNDED. NO REFUNDS WILL BE GIVEN FOR RETURNED PACKAGES MISSING ANY
ITEMS.

GRANT OF LICENSE. NetPhone grants you a non-exclusive, non-transferable license to install and use the
Program on a single local area network. You may make copies of the Program for back-up.  You may transfer
the Program from a single network server to another if you erase it from the old network server. You may not
copy the Documentation, or reverse-engineer, disassemble, or decompile the Program. You may not assign,
sublicense, rent loan, or lease the Program. Any software programs and documentation owned by third parties
(“Third Party Programs”) included with the Program as optional or bundled features (i) are licensed solely for
use with the Program and (ii) are subject to the terms and conditions of the separate License Agreement
governing such Third Party Programs, that is provided on a separate sealed disk envelope.

OWNERSHIP.  The Program is a proprietary product owned by NetPhone and is protected under U.S.
copyright law and international treaty provisions. All intellectual property rights in and to the Program are
retained by NetPhone.

TERM.  This agreement is effective upon your opening this Package and, except for evaluation licenses, shall
continue until terminated. Evaluation license terminate in the number of days specified on the Package. You
may terminate this Agreement at any time by returning all copies of the Program and Documentation to the
NetPhone authorized distributor or reseller. NetPhone may terminate this Agreement if you breach any term
of this Agreement. Upon any termination, you will return all existing copies of the Program and the
Documentation to the NetPhone distributor or reseller.

LIMITED WARRANTY. NetPhone warrants that the media on which the Program is furnished shall be free
from defects in material and workmanship for a period of 90 days, beginning from date of  installation or 30
days after purchase, whichever comes first. If a defect in the media appears during that period, you may
return the Program and Documentation to NetPhone or its authorized reseller for  either replacement or, if so
elected by the NetPhone distributor or reseller, refund of your purchase price. The  foregoing constitutes your
sole remedy for breach by NetPhone  of any warranties (express or implied) made under this Agreement.
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EXCEPT FOR THE WARRANTIES SET FORTH ABOVE, THE PROGRAM AND THE
DOCUMENTATION ARE LICENSE “AS IS,” AND NETPHONE DISCLAIMS ANY AND ALL
OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION ANY
IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE,
TITLE AND NON-INFRINGEMENT. Some states do not allow the exclusion of implied warranties or
limitations on how long an implied warranty may last, so the above limitations and exclusions may not apply
to you. This warranty gives you specific legal rights, and you may also have other rights which vary from state
to state.

LIMITATION OF LIABILITY. NetPhone’s cumulative liability to you and all other parties for any loss or
damages resulting from any claims, demands, or actions arising out of or relating to the Agreement shall not
exceed the license fee you paid for the use of the Program. NETPHONE SHALL NOT BE LIABLE FOR
ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, INCLUDING LOST
PROFITS OR LOST DATA ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM
OR ANY DATA SUPPLIED THEREWITH, OR ARISING FROM THE BREACH OF THE
WARRANTY, EVEN IF NETPHONE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES. Some states do not allow the limitation or exclusion of liability for incidental or consequential
damages, so the above limitation may not apply to you.

U.S. GOVERNMENT LICENSES. The Program and the Documentation are provided with “restricted
rights”. Use, duplication or disclosure by the Government is subject to restrictions as set forth in
Subparagraph 252.227-7013 (c )(1)(ii) (Rights in Technical Data and Computer Software) of the
Department of Defense Federal Acquisition Regulations Supplement or Subparagraphs 52.227-19 ( c )(1) and
( c )(2) (Commercial Computer Software  - Restricted Rights) of Title 48 of the Code of Federal Regulations,
as applicable. Contractor/manufacturer is NetPhone, Inc., 313 Boston Post Road West, Marlborough, MA
01752.

EXPORT ASSURANCES. You agree that the Program will not be shipped, transferred, or re-exported,
directly or indirectly, into any country prohibited by the United States Export Administration Act and the
regulations thereunder or used for any purpose prohibited by such Act.

This Agreement is governed by the laws of the Commonwealth of Massachusetts.



Index

PhoneMaster User’s Guide 57

14. Index

A

Answering calls · 3, 12

C

Call Log · 10, 19, 21, 49
Call Parking · 13
Call waiting

enabling · 29
Caller ID · 30, 31, 49
Callers

identifying · 30
Calls

answering · 3, 12
creating conference · 16
dialing · 3, 11
forwarding · 28
hanging up · 12
managing · 42
putting on hold · 12
record of · 21
sending to voice mail · 16
transferring · 15

Company listing · 3, 19, 20
updating · 24

Conference calls · 16
Connecting

to server · 7
Cover Groups

enabling · 30
Creating conference calls · 16
Customizing

PhoneMaster display · 23

D

DDE · 31
Dialer · 50

Dialing
calls · 3, 11
from a directory listing · 12
from Active Call window · 12
using speed dial entries · 11

Directories · 19
Company listing · 20
modifying · 21
searching for entries in · 26
setting up · 7
sorting entries in · 26
updating · 24
Workgroup listing · 20

Do not disturb · 17, 28, 50

E

Enabling
call waiting · 29
cover groups · 30
voice mail · 29

Entering
login information · 7
password · 7

F

Features
PhoneMaster · 1

Forward Phone · 28, 50
Forwarding calls · 17, 28

H

Hanging up calls · 12
Help · 2
Hold · 53

putting calls on · 3, 12



Index

PhoneMaster User’s Guide58

I

Icons · 10
Installing

PhoneMaster · 5

L

Login information
entering · 7

M

Message lists · 35
Messages

playing · 36
Modifying

PhoneMaster display · 23
Workgroup listing · 21

N

NETphone Help · 2

P

Parking Calls · 13
Phone Book · 19

adding entries to · 20
Phone keypad functions · 41
PhoneMaster

customizing display · 23
Help · 2
installing · 5
Keystroke shortcuts · 53
starting · 3, 6
window · 9

PhoneMaster features · 1
Pick up call · 12
Picking up

calls on other extensions · 22
Playing messages · 4, 36

Putting calls on hold · 12

S

Sending calls to voice mail · 16
Server

connecting to · 7
Setting up

Company listing · 7
directories · 7
Workgroup listing · 7

Shortcut
Keystroke · 53

Speed dial entries
storing · 27

Speed dialing · 11
Starting PhoneMaster · 3, 6
System Requirements · 5

T

Tool bar · 10
Transferring calls · 15

U

Updating
Company listing · 24
directories · 24

V

Voice mail · 16
accessing · 35
changing your password · 40
enabling · 29
message lists · 35
recording a greeting · 40
return calls · 38

Voice mail mailbox
accessing · 38

Voice mail messages
forwarding · 37



Index

PhoneMaster User’s Guide 59

managing · 36
managing from telephone · 38
playing · 4, 36, 39

Voice mail phone keypad functions · 38

W

Workgroup listing · 19, 20
modifying · 21
setting up · 7


